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40GBASE-CR4/100GBASE-CRT0 Compliance Test Application—At a

Glance

Required
Equipment and
Software

The Keysight N8828A 40GBASE-CR4/100GBASE-CR10 Compliance Test
Application is an Ethernet test solution that covers the electrical timing
parameters for 40GBASE-CR4 and T00GBASE-CR10 specification (IEEE 802.3).

The 40GBASE-CR4/100GBASE-CR10 Compliance Test Application:

Lets you select individual or multiple tests to run.

Lets you identify the device being tested and its configuration.

Shows you how to make oscilloscope connections to the device under test.
Automatically checks for proper oscilloscope configuration.

Automatically sets up the oscilloscope for each test.

Allows you to determine the number of trials for each test.

Provides detailed information of each test that has been run. The result of
maximum 64 worst trials can be displayed at any one time.

Creates a printable HTML report of the tests that have been run. This report
includes pass/fail limits, margin analysis, and screen shots.

In order to run the 40GBASE-CR4/100GBASE-CR10 automated tests, you need
the following equipment and software:

For the minimum version of Infiniilum oscilloscope software, see the N8828A
release notes.

N8828A 40GBASE-CR4/100GBASE-CR10 Compliance Test Application
software and license.

For differential probing (minimum 25 GHz):

N2802A 25 GHz InfiniiMax Il Series probe amplifier.

N2803A 30 GHz InfiniiMax Il Series probe amplifier.

N2836A InfiniiMax Il 26 GHz solder-in probe head.
For single-ended probing:

SMA cables that are able to support the 10 Gb speed.
Infiniium oscilloscope:

DSA-X 90000 Q-Series oscilloscope.

DSA-X 90000A Series oscilloscope.

DSO-X 90000 Q-Series oscilloscope.

DSO-X 90000A Series oscilloscope.
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Installing the N8828A
Compliance Test Application

Installing the Software / 8
Installing the License Key / 9

If you purchased the N8828A 40GBASE-CR4/100GBASE-CR10 Compliance Test
Application separate from your Infiniium oscilloscope, you need to install the
software and license key.
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1 Installing the N8828A Compliance Test Application

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software
(see the N8828A release notes) by choosing Help > About Infiniium... from the
main menu.

2 To obtain the N8828A Compliance Test Application, go to Keysight website:
"http://www.keysight.com/find/N8828A"

3 The link for the N8828A 40GBASE-CR4/100GBASE-CR10 Compliance Test
Application will appear. Double-click on it and follow the instructions to
download and install the application software.
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Installing the N8828A Compliance Test Application 1

Installing the License Key

1 Request a license code from Keysight by following the instructions on the
Entitlement Certificate.

You will need the oscilloscope's "Option ID Number", which you can find in the
Help > About Infiniium... dialog.

2 After you receive your license code from Keysight, choose Utilities > Install Option
License....

3 Inthe Install Option License dialog, enter your license code and click Install
License.

4 Click OK in the dialog that tells you to restart the Infinilum oscilloscope
application software to complete the license installation.

5 Click Close to close the Install Option License dialog.
6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license
installation.
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1 Installing the N8828A Compliance Test Application
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Methods of Implementation

Preparing to Take
Measurements

Calibrating the Oscilloscope / 12
Starting the Compliance Test Application / 13

Before running the automated tests, you should calibrate the oscilloscope and
probe. No test fixture is required for this application. After the oscilloscope and

probe have been calibrated, you are ready to start the N8828A Compliance Test
Application and perform the measurements.

1



2 Preparing to Take Measurements

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the
Infinilum Oscilloscope and Probe,” starting on page 65.

If the ambient temperature changes more than 5 degrees Celsius from the calibration
temperature, internal calibration should be performed again. The delta between the
calibration temperature and the present operating temperature is shown in the Utilities >
Calibration menu.

If you switch cables between channels or other oscilloscopes, it is necessary to perform cable
and probe calibration again. Keysight recommends that, once calibration is performed, you
label the cables with the channel on which they were calibrated.
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Preparing to Take Measurements

Starting the Compliance Test Application

1 Ensure that the Device Under Test (DUT) is operating and set to desired test

modes.

2 To start the 40GBASE-CR4/100GBASE-CR10 Compliance Test Application:
From the Infiniium oscilloscope's main menu, choose Analyze > Automated Test
Apps > N8828A 40GBASE-CR4 100GBASE-CR10 Test App.

File View Tools Help

2

0w | e @ 5E I |

Task Flow

SetUp

Select Tests

Configure

Connect

Fun Tests

SetUp |SelectTests I Configure I Connectl Run Tests I Automation I Results I Html Reportl

Test Environment Setup

—Device Under Test (DUT)
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InfiriiSim Setup Set Channel skew | Saved Waveform

P

No Device Connected

PNA =] ConnectPNAENA |

Figure 1

Wl 0Tests |Follow instructions to describe vour test environment  |Connection: UNKNOWN |

N8828A Compliance Test Application Main Window

The task flow pane, and the tabs in the main pane, show the steps you take in
running the automated tests:
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2 Preparing to Take Measurements

Set Up Lets you identify and set up the test environment, including information
about the device under test.

The Device Identifier, User Description, and Comments are all printed in
the final HTML report.

Select the test group to be tested.

Set up InfiniiSim with the InfiniiSim Setup button.

With the Set Channel skew button, the channels can be visually adjusted
and skewed.

The Saved Waveform Setup button enables easy setup of saved
waveforms. When waveforms are set up, the application will make all
measurements on the saved waveforms.

The Multi-Lane Option lets you choose to test a single lane, with the
switch matrix, or four differential probes (for CR4 only). When switch
matrix or four differential probes is selected, the application will
automatically switch and test each lane.

Select Tests Lets you select the tests you want to run. The tests are organized
hierarchically so you can select all tests in a group. After tests are run,
status indicators show which tests have passed, failed, or not been run,
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test,
Number of Ul to test, scope bandwidth, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test
need to be changed while multiple tests are running, the tests pause, show
you how to change the connection, and wait for you to confirm that the
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the
application.
Results Contains more detailed information about the tests that have been run. You

can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test with TX Disabled / 18
Common Mode Voltage Test / 19

Common Mode AC Output Voltage Test / 20

Amplitude Peak to Peak Output Voltage Test / 21

This section provides the Methods of Implementation (MOls) for the
40GBASE-CR4 and 1T00GBASE-CR10 Main Voltage Measurements using a
Keysight Infinilum oscilloscope and the N8828A Compliance Test Application.

KEYSIGHT

TECHNOLOGIES
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3 Main Voltage Measurements
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Figure 2  Probing for Main Voltage Measurements

You can use any of the oscilloscope channels as the signal source channel. Select
lane options in the Setup tab. You can identify the channels used for the
measurement signal in the Configuration tab of the Compliance Test Application.
(The channels shown in the previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Set up InfiniiSim if needed.
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Main Voltage Measurements 3

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
Dedl @i ae

SetUp Select Tests | Configure I Connect I Run Tests I Automation I Results I Html Report
E-[JO 40GBASE-CRA Tests
= ) Main Voltage Measurements (pattern: 1010)
) Differential Peak-to-Peak Output Voltage Test with T¥ disabled
) Common Mode Voltage Limits Test
) Common Mode AC Output Voltage Test
O Amplitude Peak-to-Peak Test
=[] © Jitter and Signaling Rate Measurements
0[] O Jitter (pattern: 1010)
B[] © Jitter (pattern: PRESS)
=[] © Output Waveform Measurements {pattern: PRESS)
----- [ O Transmitter DC Amplitude
----- [ Linear Fit Pulse
E-[]© abs Coefficient Step Size
E-[J] O Full Scale Range Tests
[ © Return Loss PNA/ENA Measurements
-[] © Differential Output Return Loss
----- [] © DME Differential Peak to Peak Output Voltage Test
----- [] © DME T1-Transition Position Spacing (period) Test
----- [] © DME T2-Clock Transition to Clock Transition Test
----- [] © DME T3-Clock Transition to Data Transition Test
----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test
----- [] © EEE Common Mode Voltage Deviation Test

[ © signaling Rate (pattern: PRESS)
“-[]© Comman-mode Output Return Loss |}
=[] © DME/EEE Waveform Measurements

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

4 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKNOWN | V]
Figure 3  Selecting Main Voltage Measurement Tests

Main Voltage  The 40GBASE-CR4 and T00GBASEOCR10 specifications can be found in IEEE
Specifications  802.3 section 85.8.3.

Differential Peak to Peak Output Voltage with TX disabled (max 30 mV).
Common Mode Voltage (0-1.9 V).

Common Mode AC Output Voltage (max 30 mV).

Amplitude Peak to Peak Output Voltage (max 1200 mV).
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Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test with TX Disabled

18

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that when TX is disabled the peak-to-peak
voltage is less than 30 mV.

The max peak-to-peak voltage is less than 30 mV.

1
2
3
4

Obtain sample or acquire signal data.

Check that signal is truly with TX disabled (no valid data transitions).
Measure peak-to-peak voltage of the signal.

Compare the max peak-to-peak voltage to 30 mV.
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Main Voltage Measurements 3

Common Mode Voltage Test

The purpose of this test is to verify that the common mode signal of the differential
pair is between 0-1.9 V.

This measurement can be done only with dual-single ended connection; it cannot be done
with a differential probing connection.

PASS Condition  The signal is between 0-1.9 V.

Measurement 1 Obtain sample or acquire signal data.
Algorithm 5 \/grify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

4 Compare the voltage measurement to 0-1.9 V.

Keysight N8828A 40GBASE-CR4 and TOOGBASE-CR10 Compliance Test Application Methods of Implementation 19



3

Main Voltage Measurements

Common Mode AC Output Voltage Test

20

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the common mode signal of the differential
pair rms voltage does not exceed 30 mV.

This measurement can be done only with dual-single ended connection; it cannot be done
with a differential probing connection.

The signal is less than 30 mV.

1 Obtain sample or acquire signal data.
2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

4 Compare the voltage measurement to 30 mV.
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Main Voltage Measurements 3

Amplitude Peak to Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a 1010 pattern is less than 1200 mV.

PASS Condition  The differential signal max peak-to-peak voltage on a 1010 pattern is less than
1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal connected and has a 1010 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
4 Compare the max peak-to-peak voltage to 1200 mV.
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3 Main Voltage Measurements

22 Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application Methods of



Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

Jitter and Data Rate
Measurements

Data Rate / 26
Jitter (Random Jitter, Duty Cycle Distortion, and Total Jitter) / 27

This section provides the Methods of Implementation (MQls) for the Jitter and
Data Rate Measurements using a Keysight Infiniium oscilloscope and the N8828A
40GBASE-CR4 and T00gBASE-CR10 Compliance Test Application.

KEYSIGHT

TECHNOLOGIES
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4 Jitter and Data Rate Measurements

Probing and
Connect.|0n for the 4Lane ONLY
Bus Signal Level
TEStS llllllll 2 b ] 3 —— - -

Transmitter - -

unter TP1 -5

inder Test ey [ o

cﬂel:rw-:.lLmz?-:m:;::’?:?smo DUT+
tab for cptions,
Transmitter
Under Test
DUT-
TP1
|
DUT+ NZUIEA PEGHT Scloer
Transmitter m‘"__., e -
Under Test T 802 or NSO . :b
DUT- Infiniiman |1l probe a o
aea
Q o
a o
TP1 - - -]

Lanel+
Lane2+

Lane3+
Laned+

Lane1-
Lane2-
Lane3-
Laned-

T i Note: Verify Switch and channel
ransmiier connection in Switch Matrix Setup from
under Test the Setup Tab.

<]
1®

Figure 4  Probing for Jitter and Data Rate Measurements

You can use any of the oscilloscope channels as the signal source channel. You
can identify the channels used for the measurement signal in the Configuration tab
of the Compliance Test Application. (The channels shown in the previous figure are
just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Set up InfiniiSim if needed.
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Jitter and Data Rate Measurements 4

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| H7% 1 |[@ B0

SetUp Select Tests | Configure I Connect I Run Tests I Automation I Results I Html Report
E-[JO 40GBASE-CRA Tests
=[] © Main Voltage Measurements (pattern: 1010)
: -[[] © Differential Peak-to-Peak Output Voltage Test with TX disabled
-[]© Common Mode Voltage Limits Test
-] © Common Mode AC Output Voltage Test
[ © Amplitude Peak-to-Peak Test
) Jitter and Signaling Rate Measurements
O Jitter (pattern: 1010)
B-[v] O Jitter (pattern: PRESS)
=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Transmitter DC Amplitude
----- [ O Linear Fit Pulse |}
[ © abs Coefficent Step Size
B[] © Full Scale Range Tests
-[[]© Return Loss PNA/ENA Measurements
-[] © Differential Output Return Loss
----- [] © DME Differential Peak to Peak Output Voltage Test
----- [] © DME T1-Transition Position Spacing (period) Test
----- [] © DME T2-Clock Transition to Clock Transition Test
----- [] © DME T3-Clock Transition to Data Transition Test
----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test
----- [] © EEE Common Mode Voltage Deviation Test

) Signaling Rate {pattern: PRBSS)
“-[]© Comman-mode Output Return Loss
=[] © DME/EEE Waveform Measurements

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

| 4 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | 4

Figure 5  Selecting Jitter and Data Rate Tests

Transmitter Qutput  The 40GBASE-CR4 and T00GBASE-CR10 specifications can be found in IEEE
Waveform  802.3 section 85.8.3.

Specifications . pata Rate (10.3125 +100 ppm GBd).
Max output jitter (max peak-to-peak).
Random Jitter (max 150 mUI).
Duty Cycle Distortion (max 35 mUl).
Total Jitter (max 250 mUl).
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4

Jitter and Data Rate Measurements

Data Rate

26

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the data rate mean is between 10.3125
+100 ppm.

The mean data rate is between 10.3125 +100 ppm.

1

N

N oo g &~ W

Obtain sample or acquire signal data.

Check that signal is connected and data pattern exists (PRBS9 must be used
for this test).

Set memory depth to capture the number or Ul set in the configuration tab.
Set data rate measurement to semi-automatic 10.3125 Gb/s.

Measure min, max, mean data rate.

Report min and max values.

Compare and report the mean data rate value to 10.3125 +100 ppm GBd.
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Jitter and Data Rate Measurements

Jitter (Random Jitter, Duty Cycle Distortion, and Total Jitter)

PASS Conditions

Measurement
Algorithm

The purpose of this test is to verify that differential signal's Random Jitter is less
than 150 mUl, Duty Cycle Distortion is less than 35 mUI, and Total Jitter is less
than 250 mUI. If all tests are selected, all tests are run on a single measurement.
Each test can be run individually by selecting any or some of the tests.

N

Random Jitter rms is less than 150 mUI.
Duty Cycle Distortion is less than 35 mUI.
Total Jitter at BER of 10E-12 is less than 250 mUI.

Obtain sample or acquire signal data.

Check that the signal is connected and data pattern exists (PRBS9 must be
used for this test).

Set memory depth to capture the number or Ul set in the configuration tab.

Set clock recovery to OJTF First Order PLL with Nominal Data Rate
10.3125 Gb/s and Loop Bandwidth to 4 MHz.

Using EZJIT, measure Random Jitter, Deterministic Jitter, Duty Cycle
Distortion, and Total Jitter at BER of 10E-12.

Compare and report the values to their respective maximum specification.

Keysight N8828A 40GBASE-CR4 and TOOGBASE-CR10 Compliance Test Application Methods of Implementation
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4 Jitter and Data Rate Measurements
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

Transmitter Output Waveform
Measurements

Transmitter DC Amplitude / 32
Linear Fit Pulse / 33

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform Measurements for Transition Time using a Keysight Infiniium
oscilloscope and the N8828A 40GBASE-CR4 and TOOGBASE-CR10 Compliance
Test Application.
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5  Transmitter Output Waveform Measurements
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Figure 6  Probing for Transmitter Output Waveform Measurements

You can use any of the oscilloscope channels as the signal source channel. You
can identify the channels used for the measurement signal in the Configuration tab
of the Compliance Test Application. (The channels shown in the previous figure are
just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Set up InfiniiSim if needed.
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Transmitter Output Waveform Measurements

node or group to check all the available tests within the group.

File View Tools Help

D@ Hd| @21 |&=(e

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report
e

B[] 40GBASE-CR4 Tests
EID ) Main Voltage Measurements (pattern: 1010)
-[[] © Differential Peak-to-Peak Output Voltage Test with TX disabled
-[]© Common Mode Voltage Limits Test
-] © Common Mode AC Output Voltage Test
[ © Amplitude Peak-to-Peak Test
=[] © Jitter and Signaling Rate Measurements
B[] Jitter (pattern: 1010)
&[] O Signaling Rate (pattern: PRESS)
[ © Jitter {pattern: PRBSS)
=[] © Output Waveform Measurements {pattern: PRESS)
----- O Transmitter DC Amplitude
----- ) Linear Fit Pulse
Connect E-[]© abs Coefficient Step Size |}
E-[J] O Full Scale Range Tests
[ © Return Loss PNA/ENA Measurements
-[] © Differential Output Return Loss
Run Tests “-[]© Comman-mode Output Return Loss

SetUp

Select Tests

Configure

----- [] © DME Differential Peak to Peak Output Voltage Test

----- [] © DME T1-Transition Position Spacing (period) Test

----- [] © DME T2-Clock Transition to Clock Transition Test

----- [] © DME T3-Clock Transition to Data Transition Test

----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test

----- [] © EEE Common Mode Voltage Deviation Test

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

2 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure 7 Selecting Transmitter Output Waveform Test

The 40GBASE-CR4 and T00GBASE-CR10 specifications can be found in IEEE

802.3 section 85.8.3.
Transmitter DC Amplitude (340-600 mV).
Linear Fit Pulse (0.63 * DC Amplitude).

5

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.
8 Click the Select Tests tab and check the tests you want to run. Check the parent
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Transmitter DC Amplitude

32

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the Transmitter DC Amplitude as described
in section 85.8.3.3 is between 0.34 and 0.6 V.

The Transmitter DC Amplitude is between 0.34 and 0.6 V.

1 Check that signal is connected and the proper data pattern exists (PRBS9 is
required for this test).

2 Setthe memory depth and sample rate to capture the 511 bits of the PRBS9
pattern for M = Np+1 points per bit.

3 Calculate Transmitter DC amplitude using the equations in section 85.8.3.3.5.
The result value is the sum of the columns of P1 (Equ 85-9).

4 Compare and report the result to 0.34-0.6 V.
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Linear Fit Pulse

The purpose of this test is to verify that the Linear Fit Pulse as described in section
85.8.3.3 is greater than the Transmitter DC Amplitude * 0.63.

PASS Condition  The Linear Fit Pulse is greater than Transmitter DC Amplitude * 0.63.

Measurement 1 Check that signal is connected and the proper data pattern exists (PRBS9 is
Algorithm required for this test).

2 Setthe memory depth and sample rate to capture the 511 bits of the PRBS9
pattern for M = Np+1 points per bit.

3 Calculate Linear Fit Pulse using the equations in section 85.8.3.3.5. The result
value read column wise from P1 (Equ 85-9).

4 Compare and report the result to 0.63* Transmitter DC Amplitude.
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Transmitter Output Wavetorm
abs Coefficient Step Size
Measurements

inc ¢(0) hold c(-1) hold / 38
dec c(0) hold c(-1) hold / 39
hold c(0) inc c(-1) hold / 40
hold c(0) dec c(-1) hold / 41
hold ¢(0) hold c(-1) inc / 42
hold c(0) hold c(-1) dec / 43

Abs Coefficient Step Size c(1
Abs Coefficient Step Size c(1
Abs Coefficient Step Size c(
Abs Coefficient Step Size c(
Abs Coefficient Step Size c(
(

1
1
1
Abs Coefficient Step Size c(1

—_— — — ~— ~— ~—

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform abs Coefficient Step Size Measurements using a Keysight
Infiniium oscilloscope and the N8828A Compliance Test Application.

KEYSIGHT

TECHNOLOGIES
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Figure 8  Probing for Transmitter Output Waveform - Abs Coefficient Step Size
Measurements

You can use any of the oscilloscope channels as the signal source channel. You
can identify the channels used for the measurement signal in the Configuration tab
of the Compliance Test Application. (The channels shown in the previous figure are
just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
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Transmitter Output Waveform - abs Coefficient Step Size Measurements

6 Setup InfiniiSim if needed.
7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
DEedl @i ae

SetUp Select Tests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

Task Flow _

»

—
B[]0 40GBASE-CR4 Tests

EID ) Main Voltage Measurements (pattern: 1010)

-[[] © Differential Peak-to-Peak Output Voltage Test with TX disabled
-\[1© Common Mode Voltage Limits Test

-] © Common Mode AC Output Voltage Test

10 Amplitude Peak-to-Peak Test

O Jitter and Signaling Rate Measurements

1O Jitter (pattern: 1010)

#-[]© signaling Rate (pattern: PRESS)

Configure #-[] O Jitter (pattern: PRBSS)

=[] © Output Waveform Measurements {pattern: PRESS)

----- [1© Transmitter DC Amplitude

----- [ O Linear Fit Pulse

SetUp

Select Tests

m

Connect
abs Coeffident Step Size c{1)inc c{0)hold cf-1)hold

abs Coeffident Step Size c{1)dec c(0)hold c{-1)hold I
abs Coeffident Step Size c{1)hold c{0)inc cf-1)hold

abs Coeffident Step Size c{1)hold c{0)dec c{-1)hold

abs Coeffident Step Size c{1)hold c{0)hold c(-1)inc

abs Coeffident Step Size c{1)hold c{0)hold c(-1)dec

E-[J] O Full Scale Range Tests

) Return Loss PNA/ENA Measurements

-1 O Differential Qutput Return Loss

i[]© Comman-mode Output Return Loss

=[] © DME/EEE Waveform Measurements

----- [] © DME Differential Peak to Peak Output Voltage Test

----- [] © DME T1-Transition Position Spacing (period) Test

----- [J© DME T2-Clock Transition to Clock Transition Test

----- [J© DME T3-Clock Transition to Data Transition Test i

™1 7 FFF Niffarantizl Dasl #n Dasl Cdeok Walbana Tack with TV dieshlad

Run Tests

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

6 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure9  Selecting Transmitter Output Waveform - Abs Coefficient Step Size Test
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Transmitter Output Waveform - abs Coefficient Step Size Measurements

Abs Coefficient Step Size c(1) inc c(0) hold c(-1) hold

38

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference amplitude between
coefficient updates falls between the specified values 0.0083 and 0.05.

The difference in the coefficient update when c(1) is incremented to the previous is
within 0.0083 to 0.05.

1
2
3
4
5
6
7
8
9

Obtain sample or acquire signal data.

Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.
Request that DUT be initialized.

Measure top/base amplitude (Amplitude).

Save result from step 5.

Pop up to ask user to Increment c(1). OK pressed.

Measure top/base amplitude (Amplitude?2).

Subtract Amplitude2 — Amplitudel.

10 Compare and report the values from step 9 to be in a range of 0.0083 to 0.05.
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Abs Coefficient Step Size c(1) dec c(0) hold c(-1) hold

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates, falls between the specified values of -0.0083 to -0.05.

PASS Condition  The difference in the coefficient update when c(1) is decremented to the previous
is within -0.0083 to -0.05.

Measurement 1
Algorithm

3

4

5

6

7

8

9

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

If previous abs test has not been run, request that DUT be initialized, else do
nothing.

If previous abs test has not been run, measure top/base amplitude
(Amplitude1), else Amplitudel is equal to value of previous test Amplitude2.

Save result from step b.

Pop up to ask user to Decrement ¢(1). OK pressed.
Measure top/base amplitude (Amplitude?2).
Subtract Amplitude2 — AmplitudeT.

10 Compare and report the values from step 9 to be in a range of -0.0083 to -0.05.
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Transmitter Output Waveform - abs Coefficient Step Size Measurements

Abs Coefficient Step Size c(1) hold ¢(0) inc c(-1) hold

40

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of 0.0083 to 0.05.

The difference in the coefficient update when c(0) is incremented to the previous
state is within 0.0083 to 0.05.

1
2
3
4

(3]

6
7
8
9

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

If previous abs test has not been run, request that DUT be initialized, else do
nothing.

If previous abs test has not been run, measure top/base amplitude
(Amplitude1), else Amplitudel is equal to value of previous test Amplitude2.

Save result from step b.

Pop up to ask user to Increment ¢(0). OK pressed.
Measure top/base amplitude (Amplitude?2).
Subtract Amplitude2 — AmplitudeT.

10 Compare and report the values from step 9 to be in a range of 0.0083 to 0.05.
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Abs Coefficient Step Size c(1) hold ¢(0) dec c(-1) hold

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of -0.0083 to -0.05.

PASS Condition  The difference in the coefficient update when c(0) is decremented to the previous
state is within -0.0083 and -0.05.

Measurement 1
Algorithm

3

4

5

6

7

8

9

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

If previous abs test has not been run, request that DUT be initialized, else do
nothing.

If previous abs test has not been run, measure top/base amplitude
(Amplitude1), else Amplitudel is equal to value of previous test Amplitude2.

Save result from step b.

Pop up to ask user to Decrement ¢(0). OK pressed.
Measure top/base amplitude (Amplitude?2).
Subtract Amplitude2 — AmplitudeT.

10 Compare and report the values from step 9 to be in a range of -0.0083 to -0.05.

Keysight N8828A 40GBASE-CR4 and TOOGBASE-CR10 Compliance Test Application Methods of Implementation 47



6

Transmitter Output Waveform - abs Coefficient Step Size Measurements

Abs Coefficient Step Size c(1) hold ¢(0) hold c(-1) inc

47

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of 0.0083 to 0.05.

The difference in the coefficient update when c(-1) is incremented to the previous
state is within 0.0083 and 0.05.

1
2
3
4

(3]

6
7
8
9

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

If previous abs test has not been run, request that DUT be initialized, else do
nothing.

If previous abs test has not been run, measure top/base amplitude
(Amplitude1), else Amplitudel is equal to value of previous test Amplitude2.

Save result from step b.

Pop up to ask user to Increment c(-1). OK pressed.
Measure top/base amplitude (Amplitude?2).
Subtract Amplitude2 — AmplitudeT.

10 Compare and report the values from step 9 to be in a range of 0.0083 to 0.05.
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Abs Coefficient Step Size c(1) hold ¢(0) hold ¢(-1) dec

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of -0.0083 to -0.05.

6

PASS Condition  The difference in the coefficient update when c(-1) is decremented to the previous
state is within -0.0083 and -0.05.

Measurement 1
Algorithm

3

4

5

6

7

8

9

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

If previous abs test has not been run, request that DUT be initialized, else do
nothing.

If previous abs test has not been run, measure top/base amplitude
(Amplitude1), else Amplitudel is equal to value of previous test Amplitude2.

Save result from step b.

Pop up to ask user to Decrement c(-1). OK pressed.
Measure top/base amplitude (Amplitude?2).
Subtract Amplitude2 — AmplitudeT.

10 Compare and report the values from step 9 to be in a range of 0.0083 to 0.05.

Keysight N8828A 40GBASE-CR4 and TOOGBASE-CR10 Compliance Test Application Methods of Implementation
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

Transmitter Output Waveform
- Full Scale Range
Measurements

Minimum Pre-cursor Full-scale Test / 48
Minimum Post-cursor Full-scale Test / 49

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform Full-Scale Range Measurements using a Keysight Infiniium
oscilloscope and the N8828A Compliance Test Application.

KEYSIGHT

TECHNOLOGIES
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Probing and
Connection for the
Bus Signal Level
Tests

Test Procedure

46
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Figure 10  Probing for Transmitter Output Waveform - Full Scale Range Measurements

You can use any of the oscilloscope channels as the signal source channel. You
can identify the channels used for the measurement signal in the Configuration tab
of the Compliance Test Application. (The channels shown in the previous figure are
just an example.)

1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Set up InfiniiSim if needed.
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Transmitter Output Waveform - Full Scale Range Measurements ~ /

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| H7% 1 |[@ B0

Task Flow _

SetUp Select Tests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—

B[]0 40GBASE-CR4 Tests

EID ) Main Voltage Measurements (pattern: 1010)

: -[] © Differential Peak-to-Peak Output Voltage Test with TX disabled
-] © Common Mode Voltage Limits Test

~[] ' Common Mode AC Qutput Voltage Test

~[]© Amplitude Peak-to-Peak Test

O Jitter and Signaling Rate Measurements

-] O Jitter (pattern: 1010)

-[]© Signaling Rate (pattern: PRESS)

-[]© Jitter (pattern: PRBSS)

=[] © Output Waveform Measurements {pattern: PRESS)

~[]© Transmitter DC Amplitude

-] O Linear Fit Pulse

[ O abs Coefficient Step Size

) Full Scale Range Tests

O Minimum Pre-cursor Full-scale Ratio

: O Minimum Post-cursor Full-scale Ratio |}
Run Tests B[] © Return Loss PNA/ENA Measurements

[ © Differential Qutput Return Loss

SetUp

Select Tests

(|

1E3)

1E3)

Configure

e

Connect

=[] © DME/EEE Waveform Measurements
~[] ) DME Differential Peak to Peak Output Voltage Test
-[] ) DME T1-Transition Position Spacing {period) Test
-] © DME T2-Clock Transition to Clock Transition Test
-] © DME T3-Clock Transition to Data Transition Test
-[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
-~[] © EEE Differential Peak to Peak Output Voltage Test
[J© EEE Common Mode Voltage Deviation Test

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

2 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure 11  Selecting Transmitter Output Waveform - Full Scale Range Tests
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Transmitter Output Waveform - Full Scale Range Measurements

Minimum Pre-cursor Full-scale Test

48

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the minimum Pre-cursor is greater than or
equal 1.54.

When the coefficients are set to c(1) zero c(0) minimum and c(-1) minimum, the
pre-cursor full-scale ratio is greater than or equal 1.54.

1

2
3
4

(3]

Obtain sample or acquire signal data.
Check that the signal is connected and data pattern exists (PRBS9 pattern).
Set memory depth to capture the number or Ul set in the configuration tab.

Pop up to ask user to supply sufficient increment or decrement requests to set
c(1) zero ¢(0) minimum and c(-1) minimum. OK pressed.

Measure Vpreshoot and Vtop of the signal.
Calculate the pre-cursor Vpreshoot/Vtop.
Report and compare the value calculated in step 6 with 1.54.
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Minimum Post-cursor Full-scale Test

The purpose of this test is to verify that the minimum Post-cursor is greater than or
equal to 4.

PASS Condition ~ When the coefficients are set to c(1)minimum c¢(0) minimum and c(-1) zero, the
post-cursor full-scale ration is greater than or equal to 4.

Measurement 1 Obtain sample or acquire signal data.

Algorithm 5 Check that the signal is connected and data pattern exists (PRBS9 pattern).
3 Set memory depth to capture the number or Ul set in the configuration tab.
4

Pop up to ask user to supply sufficient increment or decrement requests to set
c(1) zero ¢(0) minimum and c(-1) minimum. OK pressed.

(3]

Measure VOvershoot and Vtop of the signal.
6 Calculate the pre-cursor VOvershoot/Vtop.
7 Report and compare the value calculated in step 6 with 4.
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

8 Return Loss ENA/PNA
Measurements

Test Procedure

KEYSIGHT

TECHNOLOGIES

This section provides the Methods of Implementation (MOls) for the Return Loss
Measurements using a Keysight Infinilum oscilloscope, PNA or ENA, and the
N8828A Compliance Test Application. The Compliance test application controls
the PNA/ENA to set the test limits and run the test. The calibration must be done
on the PNA/ENA.

1

Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

Calibrate the PNA or ENA.

In the Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

Set up switch matrix (if used) by clicking the Switch Matrix Setup button.

Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

Press Run. The test limits are automatically calculated.
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File View Tools Help
D d| H3 1 |2 B0

SetUp SelectTests | configure | Connect | Run Tests | Automation | Resuits | Hemi Report |

—
1O 40GBASE-CR4Tests
-[[]© Main Voltage Measurements (pattern: 1010)
[] © Differential Peak-to-Peak Output Voltage Test with TX disabled
[J© Common Mode Voltage Limits Test
o []© Common Mode AC Output Voltage Test
[]© Jitter {pattern: PRBESS)
=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Transmitter DC Amplitude |}
----- [ O Linear Fit Pulse
[ © abs Coefficent Step Size
B[] © Full Scale Range Tests
) Return Loss PNA/ENA Measurements
----- [] © DME T1-Transition Position Spacing (period) Test
----- [] © DME T2-Clock Transition to Clock Transition Test
----- [] © DME T3-Clock Transition to Data Transition Test
----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test
----- [] © EEE Common Mode Voltage Deviation Test

“[]© Amplitude Peak-to-Peak Test
=[] © Jitter and Signaling Rate Measurements
' Differential Qutput Return Loss
O Common-mode Output Return Loss

1O Jitter (pattern: 1010)
[1© signaling Rate (pattern: PRESS)
=[] © DME/EEE Waveform Measurements
----- [] © DME Differential Peak to Peak Output Voltage Test

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

2Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | 4

Figure 12  Selecting Return Loss Measurement
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

DME/EEE Waveform
Measurements

DME Differential Peak-to-Peak Output Voltage Test / 56

DME T1-Transition Position Spacing (Period) Test / 57

DME T2-Clock Transition to Clock Transition Test / 58

DME T3-Clock Transition to Data Transition Test / 59

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled / 60
EEE Differential Peak-to-Peak Output Voltage Test / 61

EEE Common Mode Deviation Voltage Test / 62

This section provides the Methods of Implementation (MQOls) for the DME and EEE
Waveform Measurements using a Keysight Infiniium oscilloscope and the N8828A

Compliance Test Application.
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9  DME/EEE Waveform Measurements

Probing and
Connection for the 4Lane ONLY
Bus Signal Level
Tests.

Infirvaras 1l

Transmitter

: ” e .
I
n ==
under Test - TP1 ey )
Laned: "~ = |
Note: You have selected FOUR
cfferertial probe connections. See seup DUT+
tab for options.

Transmitter
Under Test
DUT-
TP1
|
DUT+ NZUIEA PEGHT Scloer
) Probe He
Transmitter — B
Under Test — N2B02A or N29U3A & b
DUT- Infiniiman |1l probe ; :
o-a
TP1 5 Q ;m

Lanel+
Lane2+

Lane3+
Laned+

Lane1-
Lane2-
Lane3-
Laned-

T i Note: Verify Switch and channel
ransmiier connection in Switch Matrix Setup from
under Test the Setup Tab.

<]
1®

Figure 13  Probing for DME/EEE Waveform Measurements

You can use any of the oscilloscope channels as the signal source channel. You
can identify the channels used for the measurement signal in the Configuration tab
of the Compliance Test Application. (The channels shown in the previous figure are
just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Set up InfiniiSim if needed.
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DME/EEE Waveform Measurements 9

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| H3 1 |2 B0

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—
SetU E|D ) 40GBASE-CR4 Tests
z =[] © Main Voltage Measurements (pattern: 1010)

Select Tests

=[] © Jitter and Signaling Rate Measurements
&[] O Jitter (pattern: 1010)

E-[1© signaling Rate (pattern: PRESS)
B[] Jitter (pattern: PRESS)
=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Transmitter DC Amplitude

----- [ Linear Fit Pulse

[ © abs Coefficent Step Size
B[] © Full Scale Range Tests
B[] © Return Loss PNA/ENA Measurements

=-[+] ' DME/EEE Waveform Measurements

----- ) DME Differential Peak to Peak Output Voltage Test

----- ) DME T1-Transition Position Spacing (period) Test
----- ) DME T2-Clock Transition to Clock Transition Test
----- ) DME T3-Clock Transition to Data Transition Test
----- () EEE Differential Peak to Peak Qutput Voltage Test with TX disabled |}
----- ) EEE Differential Peak to Peak Qutput Voltage Test
----- ) EEE Common Mode Voltage Deviation Test

(Click a test's name to see description)

Limit Set: IEEE 802.3 40GBASE-CR4 and 100GBASE-CR 10 Test Limit

7 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure 14 Selecting DME/EEE Waveform Tests

DME/EEE  The TOGBASE-KR DME specifications can be found in IEEE 802.3ap section 73.5.1
Waveform  Table 73-1 and section 73.5.3 Table 73-2. The T0GBASE-KR EEE specifications
Specifications  can be found in section 72.7.1 Table 72-6.

DME Differential Peak-to-Peak Output Voltage (0.6-1.2 V).

DME T1 (3.2 ns-0.01% to 3.2 ns+0.1%).

DME T2 (6.2 ns-6.6 ns).

DME T3 (3.0 ns-3.4 ns).

EEE Differential Peak-to-Peak Qutput Voltage with TX disabled (max 30 mV).
EEE Differential Peak-to-Peak Output Voltage with TX enabled (min 120 mV).
EEE Common Mode Voltage Deviation (150 mV).
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DME/EEE Waveform Measurements

DME Differential Peak-to-Peak Output Voltage Test

56

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a 1010 pattern is less than 1200 mV.

The differential signal max peak-to-peak voltage on a 1010 pattern is less than
1200 mV.

1
2
3
4

Obtain sample or acquire signal data.
Verify that there is a signal is connected and has a 1010 pattern.
Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

Compare the min and max peak-to-peak voltage to be within 0.6 to 1.2 V.
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DME T1-Transition Position Spacing (Period) Test

The purpose of this test is to verify that transition spacing of the DME signal is
3.2 ns +0.01%.

PASS Condition  The mean period is between 3.2 ns +0.01%.

Measurement
Algorithm

1
2
3
4
5

Obtain sample or acquire signal data.

Verify that there is a signal is connected.

Set memory depth to capture the number or Ul set in the configuration tab.
Request DUT in DME mode.

Measure the unit interval of the differential DME signal — set Ul measurement to
SEMI, 3.2e-9.

Compare the mean measurement to 3.2 ns +0.01%.
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9  DME/EEE Waveform Measurements

DME T2-Clock Transition to Clock Transition Test

The purpose of this test is to verify clock to clock transition is 6.2 ns to 6.6 ns.
PASS Condition  The mean period is between 6.2 ns to 6.6 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or Ul set in the configuration tab.
4 Request DUT in DME mode.

5 Measure the rising to rising edge.

6

Compare the min and max values to measurement to 6.2 ns to 6.6 ns.
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DME T3-Clock Transition to Data Transition Test

The purpose of this test is to verify clock to data transition is 3.0 ns to 3.4 ns.

PASS Condition  The min and max Ul time is between 3.0 ns to 3.4 ns.

Measurement
Algorithm

1
2
3
4
5

Obtain sample or acquire signal data.

Verify that there is a signal is connected.

Set memory depth to capture the number or Ul set in the configuration tab.
Request DUT in DME mode.

Measure the unit interval of the differential DME signal — set Ul measurement to
SEMI, 3.2e-9.

Compare the min and max values to measurement to 3.0 ns to 3.4 ns.
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EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak
voltage is less than 30 mV.

PASS Condition  The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT to be EEE mode.

3 Check that the signal is truly with TX disabled (no valid data transitions).
4 Measure peak-to-peak voltage of the signal.

5 Compare the max peak-to-peak voltage to 30 mV.
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EEE Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a 1010 pattern is greater or equal to 720 mV.

PASS Condition  The differential signal max peak-to-peak voltage on a 1010 pattern is greater than
or equal to 720 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT in EEE mode.

3 \Verify that there is a signal is connected and has a 1010 pattern.

4 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
5 Compare the min voltage to be greater than or equal to 720 mV.
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DME/EEE Waveform Measurements

EEE Common Mode Deviation Voltage Test

62

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the common mode signal of the differential
pair of the pre-LPI signal and the LPI signal is within £150 mV.

The signal voltage change between pre and post LPI is within 150 mV change.

1
2
3
4

(3]

Obtain sample or acquire signal data.
Verify that there is a signal and that the connection is dual-single ended.
Request DUT to be pre-LPl.

Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

Request DUT to be in LPI.

Measure the peak-to-peak voltage of the addition of the channell and 3 or
channel 2 and 4.

Calculate Vpp(post)-Vpp(pre).
Compare the result from step 8 to £150 mV.
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Keysight N8828A 40GBASE-CR4 and T00GBASE-CR10 Compliance Test Application
Methods of Implementation

Debug Mode

Debug mode can be selected to make enable the ability to change jitter
measurement options. In the Configuration tab, select the Debug radio button. This
will add the following options:

Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White).
This changes the amount of DC jitter in the Rj measurement.

Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data
patterns that are periodic and repeat through the scope memory. Arbitrary is
used for random data patterns or long data patterns (for example, PRBS31)
that do not repeat through the scope memory. If Arbitrary is selected, set the ISI
filters.

ISI Filter Lead — \When using Arbitrary mode for the Jitter Pattern Length, set the
Leading ISI filter coefficient. To help select the correct ISI filter, see
"Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary
Data Jitter Analysis" (at www.keysight.com, literature part number
5989-4974EN).

ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the
Lagging ISl filter coefficient. Again, to help select the correct IS filter, see
"Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary
Data Jitter Analysis".
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10 Debug Mode
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A Calibrating the Infiniium
Oscilloscope and Probe

Oscilloscope Internal Calibration / 66
Probe Calibration / 71

This section describes the Keysight Infiniium digital storage oscilloscope
calibration procedures.
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A Calibrating the Infiniium Oscilloscope and Probe

Oscilloscope Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope.
For the Keysight oscilloscope, this is referred to as Calibration.

Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the automated
tests, you need the following equipment:

Keyboard, gty = 1, (provided with the Keysight Infiniium oscilloscope).
Mouse, gty = 1, (provided with the Keysight Infiniium oscilloscope).

Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604,
gty = 2 (provided with the Keysight Infiniium oscilloscope).

Calibration cable (provided with Keysight Infiniium oscilloscopes). Use a good
quality 50 Q BNC cable.

BNC shorting cap.

BNC

Shorting Cap
(Used to calibrate
54850A series
oscilloscopes)

\ .
Precision 3.5 mm Adapters (2)

\

Calibration Cable
(Used to calibrate 54850A,
Keysight Infiniium
oscilloscopes)

Figure 15 Accessories Provided with the Keysight Infiniium Oscilloscope
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Calibrating the Infiniium Oscilloscope and Probe A

Running the Oscilloscope Internal Calibration

This Calibration will take about 20 minutes. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a

Connect the keyboard, mouse, and power cord to the rear of the
oscilloscope.

Plug in the power cord.

Turn on the oscilloscope by pressing the power button located on the lower
left of the front panel.

Allow the oscilloscope to warm up at least 30 minutes prior to starting the
calibration procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal
calibration:

a
b

c

Locate the BNC shorting cap.
Locate the calibration cable.
Locate the two Keysight precision SMA/BNC adapters.

Attach one SMA adapter to the other end of the calibration cable - hand
tighten snugly.

Attach another SMA adapter to the other end of the calibration cable - hand
tighten snugly.
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A Calibrating the Infiniium Oscilloscope and Probe

3 Referring to the following figure, perform the following steps:
a Click the Utilities > Calibration... menu to open the Calibration dialog box.

File Control Setup Measure Analyze BUEINEESN Help 9:26 AM

Calibration...

20.0 GSa/s 2.00 Mpts i Self Test... I ©GHz Reduced BW

eGUL..

GPIB Setup...
Web Control...
LXI Lan Setup...

Install Option License...

User Preferences...
Waveform Report Wizard

i eleme x| o - O o o

Source Vertical Scale Offset Horizontal Scale Position

Figure 16 Accessing the Calibration Menu

4 Referring to the following figure, perform the following steps to start the
calibration:
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A

AL Calibration Status:
Probe Comp ~ Calibration ATemp:

Calibration Date:
Time Scale Cal ATemp:
Time Scale Cal Date:

W Cal Memaory Protect

Callbrated

-5°C

31 JJL 2006 11:15:41
0°C

21 APR 2006 13:12:33

Start

Calibration Status

Common Passed

Chanrel Wertical Trigger
1 Passed Passed
2 Passed Passed
3 Passed Passed
4 Passed Passed

Aux Passed

I™ Detalls

Probe calibration is accessed via the Channel Dialogs

Figure 17 Oscilloscope Calibration Window

a Uncheck the Cal Memory Protect checkbox.
b Click the Start button to begin the calibration.

¢ During the calibration of channel 1, if you are prompted to perform a Time
Scale Calibration, as shown in the following figure, click the Std+Dflt button to
continue the calibration, using the Factory default calibration factors.
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Calibrating the Infiniium Oscilloscope and Probe

Calibration Options

Standard Calibration Std

Standard Calibration + Time Scale Calibration.  This requires an accurate 10MHz source. St + T

This should be performed once per year. s

Standard Calibration + Reset Time Scale Calibration to factary settings. St + DAt
Help

Figure 18 Time Scale Calibration Dialog Box

d When the calibration procedure is complete, you will be prompted with a
Calibration Complete message window. Click the OK button to close this
window.

e Confirm that the Vertical and Trigger Calibration Status for all Channels
passed.

f Click the Close button to close the calibration window.
g Theinternal calibration is completed.

These steps do not need to be performed every time a test is run. However, if the ambient
temperature changes more than 5 degrees Celsius from the calibration temperature, this
calibration should be performed again. The delta between the calibration temperature and the
present operating temperature is shown in the Utilities > Calibration... menu.
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Calibrating the Infiniium Oscilloscope and Probe A

Probe Calibration

Before performing the automated tests, you should calibrate the probes.
Calibration of the solder-in probe heads consist of a vertical calibration and a skew
calibration. The vertical calibration should be performed before the skew
calibration. Both calibrations should be performed for best probe measurement

performance.
Required Equipment for Probe Calibration

The calibration procedure requires the following parts.
BNC (male) to SMA (male) adapter.
Deskew fixture.
50 Q SMA terminator.

Connecting the Probe for Calibration

For the following procedure, refer to the following figure.
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Calibrating the Infiniium Oscilloscope and Probe

BNC to SMA
Connector

Pincher

Deskew . s 00 0 02— -

Fixture /

50 Q SMA / 

Terminator

Figure 19  Solder-in Probe Head Calibration Connection Example

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the
connector closest to the yellow pincher.

2 Connect the 50 Q@ SMA terminator to the connector farthest from yellow
pincher.
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Calibrating the Infiniium Oscilloscope and Probe A

3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium
oscilloscope.

4 Connect the probe to an oscilloscope channel.

5 To minimize the wear and tear on the probe head, it should be placed on a
support to relieve the strain on the probe head cables.

6 Push down the back side of the yellow pincher. Insert the probe head resistor
lead underneath the center of the yellow pincher and over the center conductor
of the deskew fixture. The negative probe head resistor lead or ground lead
must be underneath the yellow pincher and over one of the outside copper
conductors (ground) of the deskew fixture. Make sure that the probe head is
approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.

Verifying the Connection

1 On the Infiniium oscilloscope, press the [Auto Scale] key on the front panel.
2 Set the volts per division to 100 mV/div.

3 Set the horizontal scale to 1.00 ns/div.
4

Set the horizontal position to approximately 3 ns. You should see a waveform
similar to that in the following figure.

File Control  Setup  Measure  Analyze  Utlites  Help 12:24 Phd

[Taf2)

Delete
All

Eﬂ@l@l [H]

Figure 20 Good Connection Waveform Example

If you see a waveform similar to that of the following figure, then you have a bad
connection and should check all of your probe connections.
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12:21 PM.

Liilities  Help

Analyze

Measure

Contral ~ Setup

File

[Taf2)

Delete
All

Eﬂ@l@l JH| "

Figure 21 Bad Connection Waveform Example
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Running the Probe Calibration and Deskew

Calibrating the Infiniium Oscilloscope and Probe A

1 On the Infiniilum oscilloscope in the Setup menu, select the channel connected

to the probe, as shown in the following figure.

g 1 Channel 1...
@ Eechannel Zoon
'Channel &b
'Channel 4..

[ElHorizontal...

Trigger...
Trigger Shortcuts

InfiniiScan...

Acquisition...
Display...

waveform Memories...

Source Vertical Scale 0Offset

File Control Measure Analyze Utilities Help

Ctrl+1
Ctrl+2
Ctrl+3
Ctri+4

Ctrl+H
Ctri+T

Ctrl+I

Ctri+A
Ctrl+D

Alt+M

Figure 22 Channel Setup Window

8GHz Reduced BW

Horizontal Scale Position

2 Inthe Channel Setup dialog box, select the Probes... button, as shown in the

following figure.
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Channel Setup E

0000

ron - Close
Scale =l ﬂ
540 M/ %‘

Offset

00V ﬁ

Skew

00s 4/0(»

Labels Probes... |

ron It =l Trigger...

Figure 23 Channel Dialog Box

3 In the Probe Setup dialog box, select the Calibrate Probe... button.

Probe Setup =
(1 FEEEN @ 1150 I. uson  |@noprobe |
Configure Prabing System ‘ Calibrate Probe. .. ‘ Close

Help | k?

Head Label (Type) = 1169A Probe Amplifier
. - Serial #: US44001124
Head1 (N5381A:0F Sldr Berdwidt: 12.0 Gz

$= Add Head... | Edit Head... | =
Probe System

Calibration Status
Atten Cal: Uncalibrated
Skew Cal: Uincalibrated
Aftenuation:  3.3:1

Signal being prabed
« single-Ended

« Differential

Character|stics
Head1 Bandwidth: 12.0 GHz
Model: N5381A Resistance: 50.0 ke
Diff Solder-In Capacitance: 210.0 fF

Max Input: £30.0Y
Dvnrange: £1.7 W
CMrange: £8.0V

SE offset range: £16.0%

Figure 24 Probe Setup Window

4 Inthe Probe Calibration dialog box, select the Calibrated Atten/Offset radio
button.

5 Select the Start Atten/Offset Calibration... button and follow the on-screen
instructions for the vertical calibration procedure.
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Probe Calibration

Please allow 15 minutes for probe
warmup before starting calibration.

Aftenuation/Offset Calibration Value
« Default Atten/Offset
& Calibrated Atten/Offset

Start Atten/Offset Calibration... ‘

(1 FEEEN @ 1150 I. weon | @ o probe

Skew Callbration Value
& Default Skew

C Mo Skew
 Calibrated Skew

Calibrating the Infiniium Oscilloscope and Probe

l

Close

Head Label (Type) 1169A Probe Amplifier
Head! (MS381ADF Siar ~ | [Attached Head: Head1 (N5381A:Diff Solder-In)

Atten/Offset Calibration Status

Default Atten 3.3:1
Calibrated Atten Mot Calibrated (Using default values)

Skew Calibration Status

Mot Calibrated (Using default skew)

Figure 25 Probe Calibration Window

6 Once the vertical calibration has successfully completed, select the Calibrated

Skew... button.

A

7 Select the Start Skew Calibration... button and follow the on-screen instructions
for the skew calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration
was or was not successful.

Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this

verification. However, if you want to verify that the probe was properly calibrated,
the following procedure will help you verify the calibration.

The calibration procedure requires the following parts:
BNC (male) to SMA (male) adapter.
SMA (male) to BNC (female) adapter.

BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838.

Keysight 54855-61620 calibration cable (Infiniium oscilloscopes with
bandwidths of 6 GHz and greater only).

Keysight 54855-67604 precision 3.5 mm adapters (Infiniium oscilloscopes with

bandwidths of 6 GHz and greater only).

Deskew fixture.

For the following procedure, refer to the following figure.
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Calibrating the Infiniium Oscilloscope and Probe

BNC to SMA
Connector

Pincher

Deskew . s 00 00 02— :

Fixture /

50 Q SMA / 

Terminator

Figure 26 Probe Calibration Verification Connection Example

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the
connector closest to the yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the
yellow pincher.
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3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the
deskew fixture to one of the unused oscilloscope channels. For infiniium
oscilloscopes with bandwidths of 6 GHz and greater, use the 54855-61620
calibration cable and the two 54855-64604 precision 3.5 mm adapters.

4 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium
oscilloscope.

5 Connect the probe to an oscilloscope channel.

6 To minimize the wear and tear on the probe head, it should be placed on a
support to relieve the strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head
resistor lead underneath the center of the yellow pincher and over the center
conductor of the deskew fixture. The negative probe head resistor lead or
ground lead must be underneath the yellow pincher and over one of the outside
copper conductors (ground) of the deskew fixture. Make sure that the probe
head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.
9 On the oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the channel connected to the BNC cable from
the pull-down menu.

11 Select the Probes... button.

12 Select the Configure Probe System button.

13 Select User Defined Probe from the pull-down menu.

14 Select the Calibrate Probe... button.

15 Select the Calibrated Skew radio button.

16 Once the skew calibration is completed, close all dialog boxes.

17 Select the Start Skew Calibration... button and follow the on-screen instructions.
18 Set the vertical scale for the displayed channels to 100 mV/div.

19 Set the horizontal range to 1.00 ns/div.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms
overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the
dialog box, you should see waveforms similar to that in the following figure.
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Liilities  Help

Analyze

Measure

Setup

File

Contral

More
[2af2)

Delete
All

Figure 27 Calibration Probe Waveform Example

Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch
probes between channels or other oscilloscopes, or it will be necessary to calibrate them
again. It is recommended that the probes be labeled with the channel on which they were

calibrated.
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